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Teacher Mannual
(Computers)

Class I
Chapter 1

SCHOLASTIC TASK
A. 1. (b) 2. (a) 3. (b) 4. (a) 
B. 1. T 2. F 3. T 4. T 
CO-SCHOLASTIC TASK
A.	Computer, Mobile, Mouse 
B.

Natural things Man-made things
Girl Glass, Pizza and Table.
Dog Notebook.

Bicycle.

Chapter 2
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (b) 4. (c) 
B. 1. Monitor 2. Mouse 3. Keyboard 4. CPU 
C. 1. shows 2. type 3. select 4. brain
D. 1. There are four types of keys on the keyboard. They are: 
Alphabet keys	 :	 A to Z
Number keys	 :	 0 to 9
Special keys	 :	 Spacebar, Enter etc.
Function keys	 :	 F1 to F12
2. Computer is an electronic device which takes in the information and gives out the result. 3. 
A computer has five parts. They are:
	 i)	 Monitor
	 ii)	 Mouse
	 iii)	 Keyboard
	 iv)	 Speakers
	 v)	 CPU
E. 1. MOUSE 2. CPU 3. KEYBOARD 4. SCANNER 5. PRINTER 6. MONITOR. 
CO-SCHOLASTIC TASK
1.	 CPU 2. Monitor 3. Mouse

Chapter 3
SCHOLASTIC TASK
A. 1. (b) 2. (c) 3. (b) 4. (c) 5. (b) 
B. 1. 4 2. 10 3. 26 
C. 1. Backspace  keys 2. Enter key 3. Alphabet key 
D. 1. (d) 2. (c) 3. (b) 4. (a) 
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E. 1. T 2. F 3. F 4. T 5. T 
F. 1. A monitor displays information and is also used to watch movies or drawing and 
colouring images. 3. We must take care of the monitor as liquid is filled in its screen and 
it should never be touched by a sharp thing. 2. Alphabet keys are marked from A to Z. 
1. There are two enter keys visible on the keyboard.
CO-SCHOLASTIC TASK
Do it yourself.

Chapter 4
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (c) 4. (b) 
B. 1. MOUSE 2. CLICK 3. RIGHT 4. LEFT 5. SCROLL 
C. 1. wire 2. pointer 3. three 4. clicking 5. mouse. 
D. 1. T 2. T 3. T 4. T 5. T 6. T
CO-SCHOLASTIC TASK
1. Single click 2. Pointer 3. Mouse Pad

Test Paper A
A. 1. (b) 2. (b) 3. (b) 4. (c) 5. (b) 
B. 1. MONITOR 2. PRINTER 3. SCANNER 4. KEYBOARD 5. CPU 6. MOUSE 
C. 1. T 2. T 3. F 4. T 5. T 
D. 1. 26 2. 10 3. 4 
E. 1. (d) 2. (c) 3. (b) 4. (a) 
F. 1. Computer is an electronic device which takes in the information and gives out the re-
sult. 2. We must take care of the monitor as liquid is filled in its screen and it should never 
be touched by a sharp thing.

Chapter 5
SCHOLASTIC TASK
A. 1. F 2. T 3. F 4. T 
B. 1. games 2. lines and figures 3. alphabet and numbers 4. sums. 
C. 1. A computer is used to play various games. 2. It is also used to draw lines and figures. 
D. Drawing, Play songs, Do Calculations, Play games.
CO-SCHOLASTIC TASK
A. 4. Home 3. Office 2. School 1. Hospital
B.	Do it yourself 

Chapter 6
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (b) 4. (c) 
B. 1. T 2. T 3. T 
C. 1. We should not push any part of the computer as it will disturb the cable connections.
2. Yes 3. We should sit straight in front of the computer. 4. We should keep the mouse on 
the mouse pad. 
CO-SCHOLASTIC TASK
We should save all our work and close all the programmes before turning ‘OFF’ the com-
puter.
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Chapter 7
SCHOLASTIC TASK
A. 1. (c) 2. (b) 3. (b) 
B. 1. (d) 2. (a) 3. (b) 4. (c) 
C. 1. T 2. T 3. T 
D. 1. We can draw pictures on a computer using Paint program. 2. A tool box contains all 
the tools that help us to draw different shapes. 3. The drawing area is the white blank area 
where we can draw. 4. The various tools in the Tool box are: Rectangle Tool, Pencil Tool, 
Eraser Tool, Line Tool.
CO-SCHOLASTIC
1. PENCIL TOOL 2. COLOR BOX 3. DRAWING AREA.

Test Paper B
A. 1. (b) 2. (c), (b) 3. (a) 4. (a) 
B. 1. T 2. T 3. T 4. T 
C. 1. (d) 2. (a) 3. (b) 4. (c) 
D. 1. TOOL BOX 2. COLOUR BOX 3. DRAWING AREA 
E.	 1. We should not push any part of the computer as it will disturb the cable connection. 
	 2. The various components of paint window are:
	 i)	 Quick Access Toolbar
	 ii)	 Title Bar
	 iii)	 Paint Button 
	 iv)	 Tabs
	 v)	 Tool Box
	 vi)	 Color Box
	 vii)	 Drawing Area
	viii)	 Program Control
	 ix)	 Buttons
	 3.	 The drawing area is the white blank area where we can draw.
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Class II
Chapter 1

SCHOLASTIC TASK
A. 1. (c) 2. (a) 3. (b) 4. (c) 5. (c) 
B. 

Computer Man
1. A computer cannot work on its own. 

It needs the help of human beings to 
make it work.

2. Computer does not make mistakes.

1. Man can work on his own. He does 
not require anyone to make him work.

2. Man can makes mistakes.

C. 1. man 2. mistakes 3. wide 4. movies and play games 5. sum 
D. 1. Computer is a machine which runs with the help of electricity. 2. Two uses of 
computer are: (a) we can listen to music on a computer. (b) We can also pay different 
games on a computer. 3. A computer has mastermind so it never makes mistakes. It 
is a very accurate and reliable machine. 4. Computers have now become an import-
ant part of our life. Computer can perform many tasks quickly, easily and accurately. 
We can store large amount of data on a computer for a long time.
CO-SCHOLASTIC TASK
Do yourself.

Chapter 2
SCHOLASTIC TASK
A. 1. (b) 2. (a) 3. (c) 
B. 1. (iv) 2. (i) 3. (v) 4. (iii) 5. (ii) 
C. 1. BANK 2. MARKET 3. OFFICES 4. SCHOOL 5. HOME 
D. 1. withdraw 2. maps 3. the accounts of customers 4. games 5. diagnose. 
E. 1. Computers are used in banks, hospitals and markets. 2. Computers are used in hos-
pitals: (a) To help the doctors to diagnose diseases. (b) To keep the history of the patients. 
(c) To print medical reports. (d) To help the doctors in doing operations. 3. In schools, 
computers are used by teachers to teach children in an interesting manner as they act as 
an audio visual aid. 4. Mom uses computer for calculating monthly expenses at home. 5. 
Doctor uses computer to diagnose diseases. 6. Architect uses computer to make designs of 
buildings.
CO-SCHOLASTIC TASK
Do yourself

Chapter 3
SCHOLASTIC TASK
A. 1. (b) 2. (a) 3. (b) 
B. This is a joystick
	 It is a movable device
	 It is used to play games on the computer.
	 This is known as a printer. It gives the output on paper.
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	 These are speakers people listen to music from the computer through speakers.
	 This is a monitor.
	 It is used to display the result on the screen. It is also known as Visual Display Unit.
C. 1. information 2. keyboard 3. Microphone 4. speakers 
D. 1. Input devices are the hardware devices which helps us to enter input into the comput-
er. 2. Output devices are the devices which give out the results after the work is completed. 
3. A computer works on input-process-output cycle. It means the computer processes the 
input data and gives us the output.
CO-SCHOLASTIC TASK
Do yourself

Chapter 4
SCHOLASTIC TASK
A. 1. (b) 2. (a) 3. (b) 4. (b) 
B. 1. (c) 2. (a) 3. (b) 
C. 1. F 2. T 3. F 4. T 5. F 
D. 

CD-ROM FLOPPY DISK
1. The full form of CD-ROM is Com-

pact-Disc-Read-Only-Memory.
2. CD-ROM is a circular disc.

1. Floppy Disk is also known as diskette.
2. Floppy disk is a square shaped disk.

E. 1. Hard Disk can store large amount of information for us. 2. CD-ROM is the cir-
cular storage device. 3. Pen drive is the most commonly used small storage device. 
It is used to store data.
CO-SCHOLASTIC TASK
(a) HARD DISK (b) FLOPPY DISK (c) PEN DRIVE

Test Paper A
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (c) 4. (b) 5. (a) 
B. 1. (iii) 2. (iv) 3. (v) 4. (i) 5. (ii) 
C. 1. the accounts of customers. 2. withdraw 3. maps 4. Keyboard 5. Microphone 
D. 1. BANK 2. MARKET 3. OFFICES 4. SCHOOL 
E. 1.F 2. T 3. F 
F. 1. In schools, computers are used by teachers to teach children in an interesting manner 
as they act as an audio visual aid. 2. A computer works on input process-output cycle. It 
means the computer processes the input data and gives us the output.

Chapter 5
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (a) 4. (a) 5. (a) 
B. 1. (iii) 2. (iv) 3. (ii) 4. (v) 5. (i) 
C. 1. Words, Sentences and letters 2. two 3. A to Z 4. Arrow keys 
D. 1. Caps Lock key is used to type sentences in capital letters. 2. Spacebar is the longest 
key on the keyboard. 3. Function keys are used for special functions. 4. Delete key is used 
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to erase the text.
CO-SCHOLASTIC TASK
Do yourself

Chapter 6
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (c)  4. (b) 
B. 1. sign for addition 2. sign for subtraction 3. sign for multiplication 4. sign for division 
5. sign for equal to 
C. 1. T 2. T 3. F 4. T 5. T 
D. Start, Programs, Accessories, Calculator 
E. 1. Computer calculator helps us to solve sums like addition, subtraction, multiplication 
etc. 2. A Program in which a user can type text is known as Notepad. 3. Follow these steps 
to enter your school name and address in Notepad:
	 Step 1	 :	 Open the Notepad window on the topmost left corner of the working 

area, you will see a blinking cursor.
	 Step 2	 :	 Type the school name and address using the keyboard.
			   The text will start appearing and the cursor will move to the right with 

the letters or numbers.
4. Follow these steps to save a Notepad file:
	 Step 1	 :	 Click on the file menu. A list of options will appear.
	 Step 2	 :	 Click on save.
	 Step 3	 :	 The save as dialog box will appear.
	 Step 4	 :	 Type the file name here.
	 Step 5	 :	 Click on save
			   Now, our document is saved. We can see the file name on the Title bar.
CO-SCHOLASTIC TASK
Do yourself.

Chapter 7
SCHOLASTIC TASK
A. 1. (b) 2. (b) 3. (b) 4. (a) 
B. 1. T 2. F 3. T 4. F 
C. 1. curve 2. paint 3. rectangle, curved/rounded 4. any 
D. 1. The text tool is next to the image of the paint can, and has the letter “A” on it. Use this 
to type text directly onto your picture. 2. Round rectangle tool is used to draw a rectangle 
with curved/rounded corners. 3. Polygon tool is used to make a shape with any number of 
sides. 4. Text tool is used to enter text in paint. 5. Curve tool is used to draw curves to use 
curve tool, follow these steps:
	 Step 1	 :	 Click on the Home tab.
	 Step 2	 :	 Click on the curve tool.
	 Step 3	 :	 Click on the size box and select the line width.
	 Step 4	 :	 Drag the mouse on the drawing area to make a line.
	 Step 5	 :	 Now, click on the line and drag to make a curve.
6. Follow the steps given below to use polygon tool:
	 Step 1	 :	 Click on the Home tab.
	 Step 2	 :	 Click on the polygon tool.
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	 Step 3	 :	 Click on the size box and select the line width.
	 Step 4	 :	 Press the left mouse button on the drawing area and drag the mouse.
	 Step 5	 :	 Release the mouse button to make a shape.
	 Step 6	 :	 Now, click anywhere on the drawing area. A line attached to the pre-

vious line will appear.
	 Step 7	 :	 Repeat the above steps untill the desired shape is made.
	 Step 8	 :	 Now click on the starting point to close the shape.
CO-SCHOLASTIC TASK
Do yourself.

Test Paper B
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (a) 4. (a) 5. (a) 
B. 1. (iii) 2. (iv) 3. (ii) 4. (v) 5. (i) 
C. 1. sign for addition 2. sign for multiplication 3. sign for subtraction 4. sign for division 
D. Start, Programs, Accessories, calculator. 
E. 1. Curve 2. Paint 3. rectangle, curved/rounded 4. any 
F. 1. A program in which a user can type is known as Notepad. 2. Function keys are used 
for special functions. 3. Text tool is used to enter text into the picture.
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Class III
Chapter 1

SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (c) 4. (c) 
B. 1. F 2. T 3. T 4. F 5. T 
C. 1. mistakes 2. processed 3. high 4. music 5. hardware
D. 

Hardware Software
1. Hardware are the parts of a computer 

which we can touch.
2. Monitor, mouse, keyboard are some of 

the hardware parts of a computer.

1. Computer software is a program the 
tells a computer what to do.

2. Notepad, Microsoft Word, wordpad 
are some of the software programmes 
of the computer.

E. 1. Computer is a machine which runs with the help of electricity. It takes in-
formation and gives out the result after processing. 2. A computer uses input-pro-
cess-output cycle to do work. Whatever goes into the computer is called input with 
the help of input devices like keyboard, mouse, etc. We input data in a computer. 
Computer accepts the data, processes it and gives the output. 3. Computer is a fast 
working device. It has many characteristics. :
	 1.	 Speed	 :	 Computer is a very fast machine. It carries out instructions at a very 

high speed without creating any problem.
	 2.	 Accuracy	 :	 A computer does not make mistakes. It always gives accurate results.
	 3.	 Versality	 :	 A computer is a versatile machine. It can perform different types of 

tasks with same ease.
	 4.	 Storage	 :	 A computer has a wide storage memory. It can store large amount of 

data.
	 5.	 Diligence	 :	 Computer does not suffer from human traits of tiredness. It does not 

lose concentration even after working continously for a long time. 
CO-SCHOLASTIC TASK
A. Definition of computer:
Computer is a machine which runs with the help of electricity. It takes information and 
gives out the result after processing.
Parts of a computer:
There are mainly two parts of a computer:
	 1. Computer hardware
	 2. Computer software
1.	 Computer hardware: Computer hardware are the parts of the computer which we can 
touch. Example: Monitor, mouse, keyboard etc.
2.	 Computer software: Computer software is a program that tells a computer what to do. 
Some of the software programmes are: Notepad, Microsoft word, Wordpad, Paint etc.
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Uses of Computer:
A computer is a very useful machine. It is used to perform various tasks.
	 1.	 A computer can do calculations.
	 2.	 We can communicate with our friends and relatives through computer by sending 

them messages.
	 3.	 We can make new friends through chatting.
	 4.	 We can buy and sell many things on internet through various online sites.
	 5.	 We can watch movies and listen to music.
	 6.	 We can play games on computer.
	 7.	 We can create different types of documents on a computer like letters, reports, re-

sumes, etc.
B. 1. Keyboard 2. Scanner 3. Printer 4. Mouse 5. Joystick 6. Monitor.

Chapter 2
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (a) 4. (b) 5. (a)
B. 1. Hard disk drive:
Hard disk is used to store data permanently. It is located in the CPU.
2. Floppy disk drive:
It is a square shaped storage device. It helps to create small backups of data.
3. CD-ROM drive:
CD-ROM means compact Disc-Read Only memory, a CD-ROM is an optical disc which 
contains audio or software data whose memory is read only. A CD-ROM Drive is the de-
vice used to read them.
C. 1. T 2. T 3. F 4. T 5. F
D. 

Input Devices Output Devices
1. An Input device is a hardware device 

used to send data to a computer.
2. Keyboard, mouse, scanner etc. and the 

most commonly used input devices.

1. An Output device is any device that 
outputs the information from a com-
puter.

2. The most commonly output devices 
are the monitor and speakers.

E. 1. Hardware are the parts of a computer that we can see and touch. 2. There are 
many hardware components of a computer:
(a) Input Devices : Keyboard and mouse
(b) Output Devices : Monitor and speakers
(c) Storage Devices : Hard Disk, CD and DVD, Floppy Disk
(d) System Unit : CPU and motherboard
3. A mouse is a pointing device. It has two buttons and a scroll wheel on its top. We 
can draw pictures on computer by dragging and clicking the mouse. We can select 
any object on the computer with the help of the mouse. 4. A microphone is an input 
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device which helps to record sound in the computer. We can also record our voice 
into the computer through microphone.
CO-SCHOLASTIC TASK
A. 1. Input Devices:
An input device is a hardware device used to send data to a computer. Let us discuss some 
of the input devices.
1.	 Keyboard: Keyboard is the first input device. The data is input in the computer by 
pressing the buttons of the keyboard.
2.	 Mouse: A mouse is a pointing device. It has two buttons and a scroll wheel on its top. 
We can draw pictures on computer by dragging and clicking the mouse. We can select any 
objects on the computer with the help of a mouse.
2. Output Devices:
Output device is any device that outputs the information from a computer. The most com-
monly used output devices are the monitor and speakers.
1.	 Monitor: A monitor is a device that displays text, pictures and videos.
2.	 Speakers: Speakers give output in the form of sound. We can listen to music, speeches 
and other sounds through speakers.
3. Storage Devices:
A computer needs storage devices to store data.
1.	 Hard Disk : It is used to store data permanently. It can store a large amount of data. It 
is located in the CPU.
2.	 CD and DVD: The full form of a CD is Compact Disc and a DVD is Digital Versatile 
Disc. It is a circular device. It is used to store data. CD has a storage capacity of 700 MB 
and DVD has upto 4 GB.
B. 1. Mouse 2. Motherboard 3. Floppy Disk 4. Webcam 5. Scanner 6. Pen Drive

Chapter 3
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (a) 4. (b)
B. 

Operating System Software Application Software
1. Operating system software is the soft-

ware that communicates with comput-
er hardware on the most basic level.

2. MS DOS, Linux, Windows are exam-
ples of operating system software.

1. Application software contains pro-
grams that are used to perform specific 
tasks.

2. Paint, Notepad etc are examples of 
application softwares that are already 
installed in a computer. We can install 
other application software also.

C. 1. A Presentation software is used to create presentation. We can insert text, im-
ages and graphics in a presentation. For examples : Microsoft Power Point. 2. A 
game software is used to play games on a computer. There are some games software 
already installed in the computer. We can also install games software from a CD or 
internet. 3. MS DOS stands for Microsoft Disk Operating System. It is an operating 
system in which commands are given in the form of text. 4. This software enable 
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users to create and edit documents. Some examples of this software are MS Word, 
Notepad, WordPad, etc.
D. 1. Software is also called program which consists of organised set of instruc-
tions for controlling the computer. 2. Operating System software is the software 
that communicates with computer hardware on the most basic level. 3. Linux is a 
UNIX- based operating system. It is most widely used on computers for internet. 4. 
Application software contains programs that are used to perform specific tasks. 5. A 
games software is used to play games on a computer. 6. Multimedia software allows 
users to create and play audio and video files.
CO-SCHOLASTIC TASK
A. Do it yourself 
B.	1.	 Word processor
	 2.	 Spreadsheet program
	 3.	 Presentation Software
	 4.	 Games Software.

Chapter 4
SCHOLASTIC TASK
A. 1. (b) 2. (c) 3. (a) 4. (b) 
B. 1. Desktop 2. Start 3. Start 4. GUI 5. Taskbar
C. This icon displays the Internet Explorer. This icon helps us to open the local disks and 
folders. This icon is used to play music and videos in Windows Media Player.
D. 1. Follow these steps to start windows 7
	 Step 1	 :	 Turn ON the electric switch from the board.
	 Step 2	 :	 Then, turn ON the Power button from the CPU and the Monitor.
	 Step 3	 :	 Then, the Windows 7 welcome screen appears.
	 Step 4	 :	 After sometime the Windows 7 Desktop appears.
2. Follow these steps to close windows 7:
	 Step 1	 :	 Click on the start button on the taskbar. Start menu will appear.
	 Step 2	 :	 Click on Shut down button on the start menu in the button right corner.
Windows 7 will be closed. Now, we can Switch OFF the power supply button.
E. 1. An Operating system is a collection of software that manages computer hardware re-
sources and provides common services for computer programs. 2. Windows 7 is a personal 
computer operating system developed by Microsoft. 3. Taskbar is located at the bottom of 
the desktop screen. It has a start button at the left corner and a clock at the right corner. It 
contains some other icons also. Taskbar displays the programs on which we are working. 4. 
It contains a list of all the programs which are present in the computer. We can open these 
programs by clicking on them.

Assessment A
A. A computer uses input-Process-output cycle to do work. Whatever goes into the computer 
is called input with the help of input devices like keyboard, mouse, etc. We input data in a 
computer. Computer accepts the data, processes it and gives the final result as the output.
B. Webcam:
Webcams are typically small cameras that are either attached to a users monitor or on a 
desk. It is used for video conversation with other people.
Joystick:
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Joystick is a moveable input device. It has a stick that moves on its base and gives instruc-
tions to the computer. It is used to play different games on a computer.
Microphone:
A microphone is an input device which helps to record sound in the computer. We can also 
record our voice into the computer through microphone.
C. Application software contains programs that are used to perform specific tasks. It is able 
to manipulate text, numbers and graphics. We can purchase these softwares from a retail 
store or from an online website.
D. Do yourself

Assessment B
A. 1. Notepad: Notepad is a simple text editor for Microsoft Windows and a basic text 
editing Program.
2. Paint: A software that allows users to draw and colour pictures is called paint program.
3. Word Pad: Word Pad is a text-editing Program which we can use to create and edit 
documents.
4. Microsoft Word: Microsoft Word is a graphical word processing program that users 
can type with. It was made by the computer company Microsoft.
B. Output Devices: Monitor, Speakers, Printer
C. 

Ms DOS Linux Window
Ms DOS stands for Mi-
crosoft Disk Operating 
System. It was developed 
by Microsoft.

An UNIX based operat-
ing system, Linux is very 
useful for the user who 
wants a free or very low 
cost operating system.

Windows is an operat-
ing system that manages 
the document and data 
controls all the activities 
performed by the com-
puter.

D. Do yourself

Test Paper A
A. 1. (a) 2. (b) 3. (b) 4. (c) 5. (a)
B. 

Input Devices Output Devices
1. An Input device is a hardware device 

used to send data to a computer
2. Keyboard, mouse, scanner, etc. are the 

most commonly used input devices.

1. An output device is any device that outputs 
the information from a computer.

2. The most common output devices are 
the monitor and speakers.

C. 1. Ms-DOS: 
Ms DOS stands for Microsoft Disk Operating System. It was developed by Microsoft. It 
is operated by the user through typing the text commands.
2. Word Processor: 
This software enables users to create and edit documents. Some examples of this software 
are Ms Word, Notepad, Wordpad, etc.
3. Games Software: 
A game software is used to play games on a computer. There are some games software al-
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ready installed in the computer. We can also install games software from a CD or internet.
D. 1. Desktop 2. Start 3. Start 4. GUI 5. Taskbar
E. Follow these steps to start window 7:
	 Step 1	 :	 Turn ON the electric Switch from the board.
	 Step 2	 :	 Then turn ON the power button from the CPU and the Monitor.
	 Step 3	 :	 Then the Windows 7 welcome screen appears.
	 Step 4	 :	 After sometime the Windows 7 Desktop appears.
F. 1. A mouse is a pointing device. It has two buttons and a scroll wheel on its top. We can 
draw pictures on computer by dragging and clicking the mouse. We can select any object 
on the computer with the help of the mouse. 2. Windows 7 is a personal computer system 
developed by Microsoft.

Chapter 5
SCHOLASTIC TASK
A. 1. (c) 2. (a) 3. (a) 4. (a) 
B. (a) Color Palette: This Palette is used to select the colours for the drawings.
(b) Curve Tool: It is used to draw curves.
(c) Fill with color Tool: It is used to fill any colour in the drawing.
C. 1. Follow these steps to crop image:
	 Step 1	 :	 Click on the Home tab.
	 Step 2	 :	 Click on select.
	 Step 3	 :	 Select the part of the image which you want to crop.
	 Step 4	 :	 Click on Crop button. Now, only the cropped part of image will be 

seen on the page.
2. Follow these steps to save an image:
	 Step 1	 :	 Click on the paint button.
	 Step 2	 :	 Click on save The Save As dialog box will appear.
	 Step 3	 :	 Type a name in the file name text box.
	 Step 4	 :	 Click on save Now, the image will be saved in the hard disk of the 

computer.
D. 1.  2.  3.  4.  5. 
E. 1. A software that allows users to draw and colour pictures is called Paint Program. 2. 
The various tools used in paint are: Text tool, Eraser tool, Pencil tool, Fill with color tool. 
3. Follow these steps to copy and paste the image:
	 Step 1	 :	 Click on Home tab.
	 Step 2	 :	 Click on select.
	 Step 3	 :	 Select the image by dragging the mouse.
	 Step 4	 :	 To copy the image click on copy.
CO-SCHOLASTIC TASK
	 1.	 Rounded Rectangle Tool
	 2.	 Line Tool
	 3.	 Eraser Tool
	 4.	 Polygon Tool
	 5.	 Oval Tool
	 6.	 Brushes
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Chapter 6
SCHOLASTIC TASK
A. 1. (b) 2. (c) 3. (c) 4. (b) 5. (c)
B. 1. Title Bar 2. Open 3. Home tab and View tab 4. Keyboard 5. Windows
C. 1. T 2. F 3. T 4. T 5. T
D. Follow these steps to make text bold:
	 Step 1	 :	 Double-click on the text that we want to make bold.
	 Step 2	 :	 Click on the Home tab. Some commands will be seen on the Ribbon.
	 Step 3	 :	 Click on 🄱
The selected text will be highlighted.
To underline the text repeat the steps 1 and 2 as we did for bold.
Then, follow the given steps:
	 Step 1	 :	 Click on 🅄
			   Now, the selected text is underlined.
Follow these steps to make text Italic:
	 Step 1	 :	 Select the text that we want to italicize.
	 Step 2	 :	 Click on the Home tab.
	 Step 3	 :	 Click on 🄸.
			   Now, we will see that the selected text is italicized.
E. 1. Wordpad is a text-editing Program which we can use to create and edit documents. 2. 
Following are the components of wordpad window:
Title Bar: It is the bar that displays the name of the document along with program’s name.
Quick Access Toolbar: It is the toolbar that contains some shortcut buttons of commands 
like Save, Undo and Redo. We can add more buttons to the toolbar.
Program Button: It is the button that contains the menu options of the Program like New, 
Save, Print Exit etc.
Tabs: There are various tabs under which various commands are shown.
Ribbon: It contains the various commands given under the tabs.
Working Area: It is the area where the work is done by the user.
3. Follow these steps to open a document:
	 Step 1	 :	 Click on the Start button.
	 Step 2	 :	 Click on All programs.
	 Step 3	 :	 Click on Accessories.
			   A sub-menu will appear.
	 Step 4	 :	 Click on Wordpad.
The wordpad window will appear.
4. Follow these steps to make text bold:
	 Step 1	 :	 Double-click on the text that we want to make bold.
	 Step 2	 :	 Click on the Home tab. Some commands will be seen on the Ribbon.
	 Step 3	 :	 Click on 🄱
The selected text will be highlighted.
CO-SCHOLASTIC TASK
Do yourself
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Chapter 7
SCHOLASTIC TASK
A. 1. (b) 2. (a) 3. (b)
B. 1. F 2. T 3. T 4. T 5. F
C. 1. drawing tool 2. “dat” 3. Drawing canvas 4. graphic 5. date and time
D. 1. SAVE 2. ERASER 3. SHAPES 4. REDO 5. UNDO
E.	1.	 Open tool is used to open can already existing picture.
	 2.	 Magic tool is used to add special effects to the drawing.
	 3.	 The main screen of Tux paint is divided into five sections:
	 (a)	 Tool bar
	 (b)	 Color
	 (c)	 Help Area
	 (d)	 Selector
	 (e)	 Drawing Tools
	 4.	 Follow these steps to open an already existing file:
	 Step 1	 :	 Select the Open tool from Toolbox.
	 Step 2	 :	 A list of all pictures we have saved will be shown.
	 Step 3	 :	 Just double click to open or Press Ctrl + O (together).
			   Click on Undo option. It will cancel the last action of the drawing.
			   Click on Redo button. It will cancel the action done by undo button.
	 5.	 The magic tool is used to add special effects to the drawing.
	 6.	 Follow these steps to draw free hand drawing on the drawing canvas:
	 Step 1	 :	 Click on paint option on Toolbar.
	 Step 2	 :	 Select size of the brush from the selector.
	 Step 3	 :	 Select color from the color box.
	 Step 4	 :	 Click and hold the left mouse button and draw the picture in the draw-

ing canvas.
	 Step 5	 :	 Release the left mouse button when we finish drawing.

Chapter 8
SCHOLASTIC TASK
A. 1. (b) 2. (a) 3. (c) 4. (c) 
B. 1. Microphone: Microphone is used to record sound into the computer.
2. Joystick: Joystick is used to play games on a computer.
3. Colour Monitor: Colour Monitor is the first requirement of a multimedia system. It 
should be capable of displaying animations, videos, graphics etc.
4. Sound Card: A sound card is necessary for a mutimedia system. It enables a computer 
to play sound.
C. 1. CD-ROM and DVD-ROM 2. record 3. training 4. integated 5. Colour Monitor
D.	1.	 Multimedia uses a combination of images, words and sounds to present information. 
	 2.	 Following are the devices necessary for a multimedia system: 
		  Colour Monitor
		  CD-ROM and DVD-ROM
		  Speakers and sound card
		  Joystick
		  Microphone and Headphone
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	 3.	 Headphone with Microphone is used to record as well as listen to sound from the 
computer.

	 4.	 Follow these steps to play a music CD:
	 Step 1	 :	 Insert a music CD in CD-ROM of a computers. The CD will take a 

few minutes to start.
	 Step 2	 :	 The Playing window will appear. The CD will begin to play.
CO-SCHOLASTIC TASK
A. Do yourself.
B.	1.	 Headphone
	 2.	 Joystick
	 3.	 Colour Monitor
	 4.	 Speakers

Assessment C
A. Do yourself
B. Do yourself
C. Applications of Multimedia:
	 	Software: Multimedia is used for training purpose or as a guide. Hence, users can 

operate software without the help of trainers.
	 	Business Communication: Multimedia is a very powerful tool for enhancing the 

quality of business communication.
	 	Multimedia Web Pages: Multimedia features in web pages make it more attractive 

and user friendly.
	 	Multimedia Presentation: Multimedia presentation can be used to clearly explain a 

subject matter to anyone.
	 	Entertainment: Multimedia technology is used by entertainment industry in games, 

films, cartoons animation, sound effects etc.
D. Follow these steps to select text in Wordpad:
Selecting a word: 
Double-click on the word that we want to select.
Selecting a Line: 
Single-click on the line that we want to select. Now, drag the mouse to the end of the line.
Selecting a Paragraph: 
Triple-click on the paragraph which you want to select.

Assessment D
A. Do yourself

B.	1.	 Minimize button 

		  When this buton is clicked, the program window is displayed on the taskbar.

	 2.	 Maximize button 

		  When this button is clicked, the program window is displayed on the entire desktop.
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	 3.	 Close button 
		  When this button is clicked, the program window closes, but before closing a mes-

sage box appears which asks whether we want to save or not, and by selecting yes or 
no the desktop screen appears.

C. Follow these steps to exit Wordpad.
	 Step 1	 :	 Click on the Wordpad button. A list of menu will appear.
	 Step 2	 :	 Click on Exit.
Now, the document is closed and the desktop screen will appear.
D. Microphone is used to record sound into the computer. Headphone with Microphone is 
used to record as well as listen to sound from the computer.

Test Paper B
A. 1. (a) 2. (b) 3. (c) 4. (b) 5. (c). 
B. 1. T 2. F 3. T 4. T 5. T
C.	1.	 Microphone: Microphone is used to record sound into the computer.
	 2.	 Joystick: It is used to play games on a computer.
	 3.	 Colour Monitor: It is the first requirement of a multimedia system. It is capable of 

displaying animations, videos, graphics, etc.
	 4.	 Sound card: It is necessary for multimedia system. It enables a computer to play 

sound.
D.	1.	 Follow these steps to crop image.
	 Step 1	 :	 Click on the Home tab.
	 Step 2	 :	 Click on select.
	 Step 3	 :	 Select the part of the image which you want to crop.
	 Step 4	 :	 Click on crop button. Now, only the cropped part of image will be 

seen on the page.
	 2.	 Follow these steps to save an image:
	 Step 1	 :	 Click on the paint button.
	 Step 2	 :	 Click on save.
			   The Save As dialog box will appear.
	 Step 3	 :	 Type a name in the File name text box.
	 Step 4	 :	 Click on Save. Now the image will be saved in the hard disk of the 

computer.
E.	1.	 Follow these steps to cut and paste an image:
	 Step 1	 :	 Click on the Home tab.
	 Step 2	 :	 Click on select.
	 Step 3	 :	 Click on cut. The image will disappear.
	 Step 4	 :	 Click on Paste and paste the image where you want to paste it.
	 2.	 Follow these steps to open documents in Wordpad:
	 Step 1	 :	 Click on Start button.
	 Step 2	 :	 Click on All Programs.
	 Step 3	 :	 Click on Accessories.
			   A Sub-menu will appear.
	 Step 4	 :	 Click on Wordpad.
			   The Wordpad window will appear.
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Class IV
Chapter 1

SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (c) 4. (b) 5. (c).
B. 1. T 2. F 3. T 4. F 5. F.
C. 1. (b) 2. (e) 3. (d) 4. (c) 5. (a). 
D.	1.	 Following are some of the earlier calculating devices:
		  Abacus, Pascaline, Napier’s Bones, Difference Engine, Analytical Engine, Tabulat-

ing Machine, Mark-I, ENIAC, EDVAC, UNIVAC-I
	 2.	 ENIAC (Electronic Numerical Integrator and Computer) was the first electronic 

computer.
	 3.	 The second generation computer used transistors where as third generation comput-

ers used Integrated circuits.
	 4.	 ENIAC was very huge in size and consumed a lot of electricity.
	 5.	 A mini computer is a type of computer that posses most of the features and capabil-

ities of a large computer but is smaller in physical size.
CO-SCHOLASTIC TASK
	 A.	 Do yourself
	 B.	 Do yourself

Chapter 2
SCHOLASTIC TASK
A. 1. (b) 2. (c) 3. (c) 4. (a)
B. 1. T 2. F 3. T 4. F 5. T 6. T
C.	1.	 CPU — Central Processing Unit
	 2.	 ALU — Arithmetic and Logic Unit
	 3.	 RAM — Random Access Memory
	 4.	 ROM — Read Only Memory
	 5.	 MU — Memory Unit
D. 1. airthmetic, logical 2. CPU 3. RAM 4. Microphone 5. Input
E.	1.	 The Parts of computer make it successful to do work very fast. The three basic func-

tions of computer are:
	 (i)	 The input devices accept data and instructions from the user.
	 (ii)	 The Processing devices work on the data according to the instructions.
	 (iii)	 The Output provide result of processing.
	 2.	 Input devices are used to feed data and instructions into the computer.
		  Keyboard, joystick, web camera, scanner, microphone and mouse are some of the 

input devices.
	 3.	 ALU stand for Arithmetic and Logic Unit. All the mathematical calculations and 

logical operations take place in this unit.
	 4.	 Primary storage is also known as the main memory of the computer. It is used to 

store input. It works as a working storage space.
CO-SCHOLASTIC TASK
	 A.	 Do yourself.
	 B.	 Do yourself.
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Chapter 3
SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (a) 4. (b) 
B. 1. Preloaded 2. Word Processor 3. Gadgets 4. Software 5. Operating System
C. 1. (b) 2. (c) 3. (d) 4. (a)
D.	1.	 Software is a program that enables a computer to perform a specific task.
	 2.	 Over the years, there have been many different versions of Windows, but the most 

popular ones are Windows 7 (released in 2009), Windows Vista (released in 2007) 
and Windows XP (released in 2001).

	 3.	 Gadgets are simple applications that we can place on the desktop. The different types 
of gadgets are calenders, clock, picture puzzle, feed headlines and many more.

	 4.	 Different types of Operating system are:
	 1.	 MS DOS
	 2.	 Microsoft Windows
	 3.	 Linux

MS DOS: 
The MS DOS stands for Microsoft Disk Operating System. It is non-graphical command 
line Operating system.

Microsoft Windows:
The Windows Operating System has been created by Microsoft in the mid 19805.
Linux: Linux is a powerful Operating System used by many computers on the internet. 
5.	Application software is a subclass of computer software that employs the capabilities of 
a computer directly and thoroughly to a task that the user wishes to perform.
Type of Application software.
1.	Word Processor: We can write a letter, design an invitation card and create many other 
kinds of documents on the word processors.
2.	Games: Different kinds of games can be played on the computer. Some of the games are 
pre-installed in the computer, while others can be downloaded from the internet.
CO-SCHOLASTIC TASK
	 A.	 Do yourself.
	 B.	 Do yourself.

Chapter 4
SCHOLASTIC TASK
A. 1. (b) 2. (b) 3. (c) 4. (c)
B. 1. Mouse Pointer 2. single Click 3. Welcome Screen 4. double click.
C.	1.	 Windows 7 which appears on the screen is known as Windows Desktop.
	 2.	 Desktop icons are the small pictures of different Programs and folders.
	 3.	 Start button consists of a list of programs that are installed in the computer.
D.	1.	 Windows 7 is the seventh version of the Microsoft Windows Operating System.
	 2.	 Desktop icons are the small pictures of different programs and folders. These icons 

are displayed on the desktop screen.
	 3.	 Notification area displays some icons that are displayed on the left side of time and 

date. It tells about the running programs or updates of the computer.
	 4.	 Start menu is used to access programs, open files and manage computer settings.

OUTPUT
(Provides result 
of Processing)
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	 5.	 Follow these steps to shut down windows 7:
	 Step 1	 :	 Click on the Start button. The Start menu will appear.
	 Step 2	 :	 Click on Shut down Windows 7 will be closed.
			   Now we can Switch OFF the computer.
CO-SCHOLASTIC TASK
	 A.	 Do yourself
	 B.	 1. Desktop Icons
		  2. Mouse Pointer
		  3. Gadgets
		  4. Start Button
		  5. Short-cut Icons
		  6. Task bar
		  7. Notification Area
		  8. Date and Time
	 C.	 Do yourself

Chapter 5
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (c)
B. 

Files Folders
1. The collection of words, numbers, etc. 

that are stored collectively at a place 
is known as a file.

1. A folder is a collection of various files.

2. The file contains information. 2. A folder contains similar files.
3. To create a file, we click on the 

start-button.
3. To create a folder, we right-click on 

the blank area of the Desktop.

C.	1.	 A small window that displays all the programs that are installed in the computer is 
called Start Menu. It also has all the files that are stored in the computer etc.

	 2.	 Follow these steps to create a folder:
	 Step 1	 :	 Right-click on the blank area of the Desktop.
			   A drop down menu appears.
	 Step 2	 :	 Click on New.
			   A drop down menu appears.
	 Step 3	 :	 Click on Folder.
	 Step 4	 :	 A folder will be created and appear on the Desktop screen. Type the 

folder name from the keyboard and press Enter Key.
	 3.	 Follow these steps to change the Screen Saver:
	 Step 1	 :	 Right click on the desktop screen. A drop down menu will appear. 

Click on personalization.
	 Step 2	 :	 Click on Screen Saver. The Screen Saver settings dialog box will appear.
	 Step 3	 :	 Click on Screen Saver arrow.
			   A drop down menu will appear.

OUTPUT
(Provides result 
of Processing)
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	 Step 4	 :	 Click on the name which you want to apply as the Screen Saver.
	 Step 5	 :	 Click on Apply and then on OK.
The Screen Saver will change and we will be reverted back to the personalization window.
	 4.	 Follow these steps to change desktop background:
	 Step 1	 :	 Right-click on the Desktop Screen.
			   A drop down menu appears.
	 Step 2	 :	 Click on Personalize action.
			   The Personalization window will appear.
	 Step 3	 :	 Click on Desktop Background.
	 Step 4	 :	 The Desktop Background window will appear. Many pictures will 

appear. We can just click on any one picture we want to apply as the 
Desktop Background.

	 Step 5	 :	 Click on Save changes.
The Desktop Background will change and we will be reverted back to the Personalization 
Window.
CO-SCHOLASTIC TASK
Do yourself

Assessment A
A. Abacus, Napier’s Bones, Pascaline

B. 

C. 

Operating System Software Application Software
1. An Operating System manages all the 

software and hardware on the comput-
er after being started.

1. Application Software is a subclass of com-
puter software that employs the capabili-
ties of a computer directly and tharoughly 
to a task that the user wishes to perform.

2. There are many different programs 
running on the computer at the same 
time.

2. Much of the time, we will have more 
than one application open at the same 
time and this is known as multitasking.

3. Types of operating software are:
(a) MS DOS
(b) Microsoft Windows
(c) Linux

3. Types of Application Software are:
(a) Word Processor
(b) Games
(c) Media Player
(d) Web Browsers
(e) Gadgets

D. 1. Windows 7 is the seventh version of the Microsoft Windows Operating System. It 
follows Windows Vista and is designed to be more efficient and fast operating system than 
its predecessor, with faster performance and fewer compatibility issues. Windows 7 also 

INPUT
(Accepts data and  
instructions from 

the user)

PROCESSING
(Works on data 
according to the 

instructions)

OUTPUT
(Provides result 
of Processing)
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includes several new features, such as multiple touch support for touch screen interfaces, a 
simple home networking system called ‘Home Group’ and an improved Windows Search 
feature.

Assessment B
A. Dot Matrix Printer 
	 Inkjet Printer
	 Laser Printer
B. Notification area displays some icons that are displayed to the left side of time and date. 
It tells about the running programs or updates of the computer.
C. The Fifth Generation computers are still being developed at present. They will involve 
the concept of Artificial Intelligence technology which will make the computer think like 
human beings.
D. Computers are classified into four categories based on their processing, speed, storage 
capacity and size. They are:
	 •	 Micro Computers
	 •	 Mini Computers
	 •	 Mainframe Computers
	 •	 Super Computers

Test Paper A
A. 1. (c) 2. (c) 3. (c) 4. (b) 5. (b)
B. 1. preloaded 2. Word Processor 3. Gadgets 4. Software 5. Operating System
C. 1. Central Processing Unit 2. Arithmetic and Logic Unit 3. Random Access Memory
D. 1. F 2. T 3. F 4. F 5. F
E. 

Files Folders
1. The collections of words, numbers,etc 

that are stored collectively at a place 
is known as a file.

1. A folder is a collection of various files.

2. The file contains information. 2. A folder contains similar files.
3. To create a file we click on start button. 3. To create a folder we right-click on 

the blank area of the Desktop.

F.	 1.	 Primary storage is also known as the main memory of the computer. It is used to 
store input. It works as a working storage device.

	 2.	 There are three types of Operating System software:
	 (i)	 MS DOS
	 (ii)	 Microsoft Windows
	 (iii)	 Linux

MS DOS:
The MS DOS stands for Microsoft Disk Operating System. It is non-graphical command 
line operating system.
Microsoft Windows:
The Windows Operating System has been created by Microsoft in the mid 1980s.
Linux:
Linux is a Powerful Operating System used by many computers on the internet.
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Chapter 6
SCHOLASTIC TASK
A. 1. (b) 2. (b) 3. (c) 4. (a) 5. (b)
B. 1. T 2. F 3. T 4. F 5. T
C.	1.	 Start
		  All Programs
		  Microsoft Office
		  Word 2010
	 2.	 File
		  Back stage view
		  Exit
		  Word 2010
D.	1.	 Microsoft word 2010 is a software that lets us create documents on a computer. We 

can use it to create beautiful text using colourful photographs or illustrations as pic-
tures or as a background and add figures like maps and tables.

	 2.	 The Quick Access Toolbar is located at the left corner of the Title bar. It lets us to 
access common commands. By default, it shows the Save, Undo and Repeat com-
mands.

	 3.	 There are two types of scroll bar present in Microsoft Word 2010:
	 (i)	 Horizontal Scroll Bar: This scroll bar allows us to move right or left on the Microsoft 

word page.
	 (ii)	 Vertical Scroll Bar: This Scroll bar allows us to move up or down on the Microsoft 

word page.
	 4.	 Follow these steps to create a new document:
	 Step 1	 :	 Click on the file tab. The Back Stage view will appear.
	 Step 2	 :	 Click on New.
	 Step 3	 :	 Click on Blank document under Available Templates.
	 Step 4	 :	 Click on Create Now, a new blank document will appear in the Mic-

rosoft Word 2010 Window.
	 5.	 Following are the steps to open a saved document in MS Word 2010:
	 Step 1	 :	 Click on the Office button.
	 Step 2	 :	 Click on the Open button. The open dialog box will appear.
	 Step 3	 :	 Click the file we want to open.
	 Step 4	 :	 Click on the open button. Our file will open in the Word Window.
	 6.	 We can view a document in many ways in Word 2010.
To view a document in different forms, follow these steps below:
	 Step 1	 :	 Click on the View tab on the Ribbon.
	 Step 2	 :	 Click on the appropriate document view.
CO-SCHOLASTIC TASK
Do yourself 

	 Chapter 7
SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (b)
B. 1. Macintosh computer 2. add text, colour and design 3. Slide 4. Backstage view
C.	1.	 These are quick access buttons of some commands of the view tab. It enables us to 
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view the presentation in different views like Normal View, Slide Sorter View and 
Slide Show View.

	 2.	 It displays the current slide number we are working on and the total number of slides 
in the presentation.

	 3.	 We can view the slides of the presentation in two ways by using this tab:
	 •	 Outline of the Slide Text and Thumbnail.
	 •	 Miniature view of the slides.
	 4.	 When this button is clicked, it shows a drop-down list of file commands like New, 

open, save, print, etc.
	 5.	 Backstage View gives us various options for saving, opening a file, printing or shar-

ing the document.
D.	1.	 Follow these the steps to start Microsoft Power Point 2010:
	 Step 1	 :	 Click on Start button. The Start Menu will appear.
	 Step 2	 :	 Click on Microsoft office. The Microsoft Office Menu will appear.
	 Step 3	 :	 Click on Microsoft Power Point 2010.
The Microsoft Power Point 2010 Window will appear as.
	 2.	 Follow these the steps given to enter text:
	 Step 1	 :	 Click on the Title text placeholder box.
	 Step 2	 :	 Type the title for the slide from the keyboard.
	 Step 3	 :	 Now, click on the subtitle text place holder box.
	 Step 4	 :	 Type the information from the keyboard.
	 3.	 Follow these steps to insert text in the slide:
	 Step 1	 :	 Click at the place where we want to add text.
			   The insertion point will flash.
	 Step 2	 :	 Enter the text from the keyboard
The text will be displayed at that place and the text will move to the right.
		  Follow these steps to delete text:
	 Step 1	 :	 Select the text we want to delete.
	 Step 2	 :	 Press the Delete key from the keyboard.
			   The text will get deleted from the slide.
	 4.	 Follow these steps to close the Microsoft PowerPoint 2010 Presentation:
	 Step 1	 :	 Click on the File tab. Backstage view appears.
	 Step 2	 :	 Click on the close button.
			   Now, the Microsoft PowerPoint 2010 Presentation will be closed.
CO-SCHOLASTIC TASK
Do yourself

Chapter 8
SCHOLASTIC TASK
A. 1. (c) 2. (b) 3. (a) 4. (b)
B.	1.	 Quick Access Toolbar
		  It is the toolbar that contains some shortcut buttons of commands like Save, Undo 

and Redo.
	 2.	 Ribbon
		  It contains the various commands given under the tabs.
	 3.	 Tabs: There are various tabs under which various commands are shown.
C.	1..	 Windows 8 is an operating system (OS) from Microsoft released on 26 October, 
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2012. Windows 8 succeeds the Previous windows 7 Operating system and represents 
the most modern upgrade of the Windows Operating System in recent decade. This 
Window is based on tiles. Windows 8 recognises the input provided by the input 
devices.

	 2.	 Follow these steps to start Windows 8:
	 Step 1	 :	 Turn ON the computer, you will see the start screen.
	 Step 2	 :	 Move the mouse pointer to the (-) sign at the right bottom corner of 

the Scroll Bar.
			   The Charms Bar will appear.
	 Step 3	 :	 Click on Search Charm
	 Step 4	 :	 Type the name of the program you want to open in the Apps Search 

Charm.
	 Step 5	 :	 Press the Enter key.
			   The Program Window will appear.
			   Here, you have opened Microsoft Word 2010.
	 3.	 We can switch between the windows, if we have two or more windows opened on the 

screen.
The active window appears in the front. It is the window in which we are working.
To display the background window, click on its icon displayed on the taskbar. The window 
will appear in the front and become the active window.
Now, we can start working in that window.
CO-SCHOLASTIC TASK
Do yourself

Chapter 9
SCHOLASTIC TASK
A. 1. (a) 2. (c)
B. 1. Internet 2. website 3. E-mail 4. Modem
C. 1. T 2. F 3. F
D.	1.	 Internet is a kind of network which conneets millions of computers across the world 

by means of cables or wireless media of communication.
	 2.	 Three uses of internet are:
	 i)	 Internet allows us to share information at a very fast speed.
	 ii)	 Internet allows us to send or receive messages using e-mails.
	 iii)	 Internet allows us to communicate across the world.
	 3.	 Following are the equipments required for an internet connection.
	 i)	 Modem
	 ii)	 Telephone connection
	 iii)	 Computer
CO-SCHOLASTIC TASK
Do yourself

Assessment C
A. Microsoft word is a software that lets us create documents on a computer. It also pro-
vides us various features for creating text so that we can complete documents, spread-
sheets and Presentations and for managing e-mail.
B. To exit from MS Word 2010, follow these steps below:
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	 Step 1	 :	 Click on the office button.
	 Step 2	 :	 Click on the X Exit word button.
We can see that the word window is closed.
C. File, Backstage, Exit, Desktop screen.

Assessment D
A. To create and design effective documents, we need to format text. It not only makes the 
document more appealing but also draws the readers attention to specific parts of the doc-
ument. In Word there are several options for adjusting the font of the text, including size, 
color and inserting special symbols.
B. Do yourself
C. Title Bar: It displays the name of the document. By default the name displayed is ‘Pre-
sentation1 - Microsoft Power Point’
File Tab: When this button is clicked, it shows a drop-down list of file command like New, 
Open, Save, Print, etc.
Slide: It is the main or current page on which we work at a time.
D. Internet Services provider Provides Internet Connection and charges a fee for using the 
Internet. Some of the common ISP’s in India are:
● MTNL ● Airtel ● Sifty Broadband ● Tikona ● BSNL

Test Paper B
A. 1. (c) 2. (b) 3. (b) 4. (c) 5. (b)
B.	1.	 We can view the slides of the Presentation in two ways by using this tab:
	 ●	 Outline of the Slide Text and Thumbnail.
	 ●	 Miniature view of the slides.
	 2.	 It displays  the current slide number we are working on and the total number of slides 

in the presentation.
C. 1. Internet 2. Website 3. E-mail 4. Modem
D. 1. Ctrl+N 2. Working Area 3. MS Word 4. Ctrl+S
E. 1. F 2. F 3. F 4. T 5. F
F.	 1.	 Follow these steps to close the Microsoft PowerPoint 2010 Presentation.
	 Step 1	 :	 Click on the File tab. Backstage view appears.
	 Step 2	 :	 Click on the close button.
			   Now, the Microsoft PowerPoint 2010 Presentation will be closed.
	 2.	 Follow these steps to open a saved document in Microsoft Word 2010.
	 Step 1	 :	 Click on the Office button.
	 Step 2	 :	 Click on the Open button.
	 Step 3	 :	 Click the file you want to open.
	 Step 4	 :	 Click on the open button. Your file will open in the Word window.
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Class V

Chapter 1
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (a) 4. (b) 5. (a)
B. 1. T 2. F 3. F 4. T 
C.	1.	 Mainframe Computer: A mainframe computer is an ultra high performance com-

puter which is made for high-volume, processor-intensive computing.
	 2.	 Minicomputer: Minicomputers are used for scientific and engineering computa-

tions, business transaction processing, file handling and database management and 
are often referred to as small or mid-size servers.

	 3.	 Microcomputer: It is the smallest of all the computers. It is also known as personal 
computer. It uses a micro processor in its CPU.

	 4.	 Supercomputer: A Supercomputer is a computer that performs at or near the cur-
rently highest operational rate for computers.

D. 

Super Computer Desktop Computer
1. A Super computer is a computer that 

performs at or near the currently high-
est operational rate for computers.

1. A desktop computer is a personal comput-
er that is designed to fit conveniently on 
top of a typical office desk.

2. It is as big as size of a room. 2. Desktop computer is designed to fit 
under the desk or in a unit that goes 
on top of the desk.

E.	1.	 Minicomputers are used for scientific and engineering computations, business-trans-
action Processing, file handling and database management and are often referred to 
as small or mid-size servers.

	 2.	 Mini computers work faster than Microcomputers Minicomputers contain one or 
more processors, support multiprocessing & tasking are generally reselient to high 
work loads.

	 3.	 The various types of Micro computer are:
	 ●	 Desktop Computer
	 ●	 Notebook Computer
	 ●	 Hand-held Computer
	 4.	 A micro computer is the smallest of all the computer. It is also known as personal 

computer.
	 5.	

Notebook Computer Hand-held Computer
1. A Notebook computer is a small, 

light-weight computer.
1. A computing device that can be easily held 

in one hand, while the other hand is used to 
operate it is called a Hand-held computer.

2. It has an in-built screen, keyboard, 
mouse and CPU

2. Some hand-held computers have an 
in-built keyboard and mouse, while 
some only have a screen to work on.
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CO-SCHOLASTIC TASK 
Do it yourself

Chapter 2
SCHOLASTIC TASK
A. 1. (c) 2. (b) 3. (a)
B.	1.	

This box is used to start and stop the flowchart. It is represented with an Oval.
	 2.	

The output of the flowchart is also represented through a Parallelogram.
	 3.	

The processing of the flow chart is shown by a Rectangular box.
C. 1.  (b)  2. (c)  3. (a)
D.	1.	 An algorithm is a stepwise set of finite instructions written to solve a problem.
	 2.	 Algorithm to add two numbers: 
	 i)	 Start
	 ii)	 Input two numbers
	 iii)	 Add the two numbers
	 iv)	 Print the result
	 v)	 Stop
	 3.	 Algorithm to multiply the two numbers 
	 i)	 Start
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	 ii)	 Input two numbers
	 iii)	 Multiply the two numbers
	 iv)	 Print the result
	 v)	 Stop
	 4.	 A flowchart is a graphical or symbolic representation of a process.
CO-SCHOLASTIC TASK
	 1.	

	 2.	

Chapter 3
SCHOLASTIC TASK
A. 1. (a) 2. (a) 3. (c) 4. (a) 5. (c) 6. (c)
B.	1.	 Documents library files
	 2.	 Pictures library files
	 3.	 Music library files

Start

Take two numbers

A & B

Subtract the

two numbers

Display the result

Stop

Start

Take two numbers

A & B

Divide the

two numbers

Display the result

Stop
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	 4.	 Videos library files
C.	1.	 Following are the steps to create a folder:
	 Step 1	 :	 Right-click the mouse on the blank area.
	 Step 2	 :	 A list of menu will appear.
			   Click on New.
	 Step 3	 :	 A sub-menu will appear.
			   Click on folder.
	 Step 4	 :	 An icon appears on the desktop.
			   Type a name that you want to give to a folder with the help of key-

board. Press the Enter key.
			   Now, the folder is created.
	 2.	 Following are the steps to delete a file or a folder:
	 Step 1	 :	 Open the folder containing the files and folders.
	 Step 2	 :	 Click on the folder that you want to delete.
	 Step 3	 :	 Click on Organize.
	 Step 4	 :	 Click on Delete.
	 Step 5	 :	 The Delete Folder dialog box will appear. It has two options – Yes or 

No.
	 Step 6	 :	 Click on Yes. The file disappears from its place and moves to the Re-

cycle Bin.
	 3.	 Following are the steps to move a file from one folder to another:
	 Step 1	 :	 Open the folder containing the files.
	 Step 2	 :	 Select the file that we want to move.
	 Step 3	 :	 Click on Organize.
	 Step 4	 :	 Click on cut.
	 Step 5	 :	 Open the folder in which you want to move the file.
	 Step 6	 :	 Click on Organize
	 Step 7	 :	 Click on paste.
			   your file appears in the new place.
	 4.	 Following are the steps to rename a file/folder:
	 Step 1	 :	 Click on the file or folder that you want to rename.
	 Step 2	 :	 Click on Organize.
	 Step 3	 :	 A drop-down list will appear. Click on Rename.
	 Step 4	 :	 A text box appears under the folders icon.
	 Step 5	 :	 Type the new name. Press the Enter key.
D.	1.	 A file is an item that contains information.
	 2.	 A folder is a container in which you can store your files you can store similar files in 

a folder with different names.
	 3.	 Files are represented with icons. This makes it easy to recognise a type of file by 

looking at its icon.
		  All the folders of the computer contain files. Some folders also contain additional 

folders. These are called sub-folders.
	 4.	 Following are the steps to select all files or folders:
	 Step 1	 :	 Open the folder containing the files or folders.
	 Step 2	 :	 Click on Organize.
	 Step 3	 :	 Click on select all.
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Now all the files and folders are selected.
CO-SCHOLASTIC TASK
Do yourself

Chapter 4
SCHOLASTIC TASK
A. 1. (a) 2. (b) 3. (a) 4. (c) 5. (b)
B.	1.	 Following are the steps to align text:
	 Step 1	 :	 Select the text that we want to align.
	 Step 2	 :	 Click on the Home tab.
	 Step 3	 :	 Click on one of the following buttons:

	 	 Left Align

	 	 Center Align

	 	 Right Align

	 	 Justify Align

We can see that the selected text is aligned.
	 2.	 Following are the steps to change the font of the text:
	 Step 1	 :	 Select the text which you want to change to a different font.
	 Step 2	 :	 Click on the Home tab.
	 Step 3	 :	 Click on the Font Arrow.
			   A drop-down list of fonts will appear.
	 Step 4	 :	 Click on the font that you want to apply on the selected text.
Now, you can see that the font of the selected text is charged to the new font.
	 3.	 Following are the steps to create a new document:
	 Step 1	 :	 Click on the file tab.
	 Step 2	 :	 A Backstage view will appear. Now click on the New Button.
	 Step 3	 :	 An Available Templates list will appear. Click on the Blank document.
	 Step 4	 :	 A Specimen copy of the selected template will appear. Click on cre-

ate.
			   you will see that a new document is opened.
	 4.	 Following are the steps to save a document:
	 Step 1	 :	 Click on the File tab.
	 Step 2	 :	 A Backstage view will appear. Click on Save or Save as.
	 Step 3	 :	 Save As dialog box will appear.
	 Step 4	 :	 Select the folder in which you want to save the document.
	 Step 5	 :	 Type a name in the file name text box.
	 Step 6	 :	 Click on save.
	 Step 7	 :	 The file name appears on the title bar.
C.	1.	 Ctrl+N
	 2.	 work area
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	 3.	 Folder
	 4.	 Ctrl+s
	 5.	 Font size Arrow button
	 6.	 (I) 
	 7.	 Insert tab.
D. 1. F 2. F 3. T 4. F
E.	1.	 Following are the steps to change the colour of the text:
	 Step 1	 :	 Select the text to change its colour.
	 Step 2	 :	 Click on the Home tab.
	 Step 3	 :	 Click on the Font color Arrow.
			   A drop-down list of colours will appear.
	 Step 4	 :	 Click on the colour that we want to apply.
Now, you will see that the colour of the selected text gets changed.
	 2.	 There are four options in Microsoft Word to align the text. They are:

	 	 Left Align

	 	 Center Align

	 	 Right Align

	 	 Justify Align

	 3.	 The insertion point appears on the work area as we create a new document.
	 4.	 Following are the steps to enter text:
	 Step 1	 :	 Type the text in the document with the help of keyboard.
	 Step 2	 :	 To start typing from a new line or a new paragraph, press the Enter key.
As you type the text after pressing the Enter key, Microsoft Word automatically wraps the 
text to the next line when you reach at the end of a line.
	 5.	 Following are the steps to open a saved document.
	 Step 1	 :	 Click on the File tab.
	 Step 2	 :	 A Backstage view will appear. Click on open.
	 Step 3	 :	 A list named Recent Documents will appear.
			   Click on the file which you want to open.
	 Step 4	 :	 An Open dialog box will appear.
	 Step 5	 :	 Select the folder where you had saved the file before.
	 Step 6	 :	 Locate the file name that you want to open.
			   File name will appear in the file name text box.
	 Step 7	 :	 Click on open. The file will open in Microsoft Word window.
CO-SCHOLASTIC TASK
Do yourself

Assessment  TaskA
A. Do yourself
B. Do yourself
C.	Following are the steps to select all files and folders:
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	 Step 1	 :	 Open the folder containing all files or folders.
	 Step 2	 :	 Click on Organize.
	 Step 3	 :	 Click on select all.
Now, all the files and folders are selected.

Assessment Task B
A.	

Symbol Name Functions

Input box To display the input of 
the flow chart, a parallel-
ogram is used.

Processing box The Processing of the 
flowchart is shown by a 
rectangular box.

Output box The output of the flow-
chart is also represented 
through a parallelogram.

Decision box This box is used to 
represent the decision or 
any condition that is to 
be met. It is represented 
with a rhombus.

Flow lines Arrows are used to join 
the various boxes. They 
are used to connect the 
flows of the flowchart 
from one step to another.

B.	
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C. We can format text to make it look beautiful and attractive. There are various ways to 
format text. For example:
	 1.	 Changing the colour of the text.
	 2.	 Bold, Italic or Underline text.
	 3.	 Changing the font of the text.
	 4.	 Changing the size of the text.
	 5.	 Aligning text.
	 6.	 Adding Word Art.

Test Paper A
A. 1. (b) 2. (b) 3. (a) 4. (c) 5. (c)
B.	

	 	 This box is used to start and stop the flowchart. It is 
represented with an oval.

	 	 The output of the flowchart is represented through a 
parallelogram.

	 	 The Processing of the flowchart is shown by a rectan-
gular box.

C.	1.	 Documents library files 
	 2.	 Pictures library files
	 3.	 Music library files
	 4.	 Videos library files
D.	1.	 Ctrl+N
	 2.	 Working Area
	 3.	 Folder
	 4.	 Ctrl+S
E. 1. F 2. F 3. T 4. F
F.	 1.	 Following are the steps to select all files and folders:
	 Step 1	 :	 Open the folde containing all files or folders.
	 Step 2	 :	 Click on organize.
	 Step 3	 :	 Click on select all.
Now ,all the files and folders are selected.
	 2.	 Following are the steps to enter text:
	 Step 1	 :	 Type the text in the document with the help of keyboard.
	 Step 2	 :	 To start typing from a new line or a new paragraph, press the Enter 

key.
As we type the text after pressing the Enter key. Microsoft Word automatically wraps the 
text to the next line when we reach at the end of a line.

Chapter 5
SCHOLASTIC TASK
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A. 1. (b) 2. (b) 3. (b) 4. (c)
B.	1.	 Following are the steps to change the layout of a slide:
	 Step 1	 :	 Open the slide that you want to change layout.
	 Step 2	 :	 Click on the Home tab.
	 Step 3	 :	 Click on the layout button.
	 Step 4	 :	 A drop-down list of various layouts will appear. Click on the layout 

that you want to apply. The new layout is applied on the slide.
	 2.	 Following are the steps to insert a picture:
	 Step 1	 :	 Open the slide in which you want to add an image.
	 Step 2	 :	 Change the layout of the slide to the layout that includes a Insert Pic-

ture Placeholder.
	 Step 3	 :	 Click on the Picture icon.
	 Step 4	 :	 Insert Picture dialog box will appear.
	 Step 5	 :	 You want browse to find the location of the image.
			   Click on the image that you want to add.
	 Step 6	 :	 Click on Insert.
The Picture will be inserted in the slide. The Picture tool will appear in the ribbon.
	 3.	 To view a slide show.
	 Step 1	 :		 Click on the first slides.
	 Step 2	 :		 Click on the slide show button. The slide show start to appear.
	 Step 3	 :		 To view next slider click on  button.
	 4.	 Following are the steps to run a slide show:
	 Step 1	 :	 Click on the first slide.
	 Step 2	 :	 Click on the slide show button to start the slide show.
			   The slide show starts to appear.
	 Step 3	 :	 To view next slide check on (→) button or click anywhere on the cur-

rent slide.
	 Step 4	 :	 To view the previous slide, Click on (←) button or the Backspace key.
	 Step 5	 :	 Keep on pressing (→) button till the last screen appears.
	 Step 6	 :	 Click on (■) screen to exit the slide show.
C.	1.	 In Microsoft PowerPoint, you can change the font size and colour of the text. You can 

also change the background colour, spacing etc. All this is known as formatting.
	 2.	 Following are the steps to change the colour of the text:
	 Step 1	 :	 Select the text of which you want to change the font color.
	 Step 2	 :	 Click on the Home tab.
	 Step 3	 :	 Click on the down arrow of font colour button.
	 Step 4	 :	 A color Palette will appear. Click on the colour which you want to 

apply.
	 3.	 In the Presentation, it is the motion effects that occur in slide show view when you 

move from one slide to another it is called transition.
	 4.	 Normal view consists of three panes, namely-outline pane, slides pane and notes 

pane.
	 5.	 Following are the steps to add textured fill colour in background:
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	 Step 1	 :	 Click on Design tab.
	 Step 2	 :	 Click on Background styles.
	 Step 3	 :	 Click on Format Background.
	 Step 4	 :	 The Format Background dialog box will appear. Click on picture or 

texture fill.
	 Step 5	 :	 Click on the Texture button.
	 Step 6	 :	 A drop-down list of texture will appear. Click on the texture we want 

to apply as a background.
	 Step 7	 :	 Click on close to apply texture on the current slide.
	 Step 8	 :	 Click on Apply to All button to apply on all slides.
B.	🄱	 Bold
	 🄸	 Italic
	 🅄	 Underline
CO-SCHOLASTIC TASK
A. Do yourself
B. Do yourself

Chapter 6
SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (b) 4. (c) 5. (a)
B.	1.	 Following are the steps to move the turtle 20 steps forward:
	 Step 1	 :	 Type FORWARD or FD in the command input box. Press Space bar.
	 Step 2	 :	 Now enter the number of steps (20) for the turtle to move forward.
	 Step 3	 :	 Press Enter key.
Thus, the turtle moves 20 steps ahead and draws a 20 unit long line.
C. 

LT Command RT Command
1. LT Command instructs the turtle to 

move in the left direction on the screen.
1. RT Command instructs the turtle to move 

in the right direction on the screen.
2. The command is followed by the de-

grees, you want the turtle to rotate left.
2. The command is followed by the 

degrees you want the turtle to rotate 
right.

3. 90 degree rotates the turtle exactly to 
the left.

3. 90 degree rotates the turtle exactly to 
the right.

D. We can perform many tasks on LOGO by:
	 ●	 Constructing a program to perform all the tasks in the right order.
	 ●	 Evaluating the program to access whether the task is performed correctly.
	 ●	 Debugging the program by locating and correcting the errors or restructuing the ap-

proach.
	 ●	 Experimenting with LOGO commands to understand them and become confident in 

their use.
	 ●	 Planning the task and organising it into its various components.
	 ●	 Writing a set of instructions to perform each small task.
E.	1.	 Forward or FD command instructs the turtle to move forward on the screen in the 

direction of the turtle's head.
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	 2.	 Backward or BK command instructs the turtle to move backward on the screen in the 
direction of the turtle's head.

CO-SCHOLASTIC TASK
Do yourself

Chapter 7
SCHOLASTIC TASK
A. 1. (c) 2. (c) 3. (a)
B.	 1.	 Tabs	 :	 Various tabs like Home, Insert, Page Layout, Formulas, 

Data Review and View are available in Microsoft Excel 
2010 window.

	 2.	 Ribbon	 :	 It displays various commands of the tabs.
	 3.	 Formula Bar	 :	 It is used to enter formulas to perform calculations on the 

data.
	 4.	 Row Headings	 :	 It displays the row numbers.
	 5.	 Column Headings	 :	 It displays the column alphabets.
C.	1.	 Microsoft Excel 2010 makes it possible to analyse, manage and share information in 

more ways than ever before. New analysis and visualisation tools help to track and 
highlight important data trends.

	 2.	 Following are the steps to enter text in Microsoft Excel 2010 worksheet:
	 Step 1	 :	 Click on the cell to enter data.
			   This cell will be highlighted with a thick border (Active cell).
	 Step 2	 :	 Enter the data from the keyboard. As you type the data you will see 

that it will appear in the formula bar also.
	 Step 3	 :	 Press the Enter key Now, the data is entered in the cell and the cell in 

the next row becomes the active cell.
	 Step 4	 :	 Repeat the above steps to enter a data in other cells.
	 3.	 Following are the steps to save Microsoft Excel 2010 workbook:
	 Step 1	 :	 Click on the File tab. Backstage view appears.
	 Step 2	 :	 Click on the Save button or Save as button.
			   The Save As dialog box appears.
	 Step 3	 :	  Click on these areas to browse the folder to save the workbook.
	 Step 4	 :	 Click on the file name text box to type the file name.
	 Step 5	 :	 Click on save.
			   The Microsoft Excel 2010 Workbook is now saved. The file name will 

appear on the Title Bar.
	 4.	 Following are the steps to open an already saved Microsoft Excel 2010 workbook:
	 Step 1	 :	 Click on the File tab. Backstage view appears.
	 Step 2	 :	 Click on the Open button.
			   A list of recently opened workbooks will appear.
	 Step 3	 :	 If you want to open a workbook from another folder, the Open dialog 

box appears.
	 Step 4	 :	 Click on these areas to locate the folder where the workbook is stored.
	 Step 5	 :	 Click on the name of the workbook you want to see.
	 Step 6	 :	 Click on open.
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The workbook will open in the Microsoft Excel 2010 program window.
	 5.	 Following are the steps to close Microsoft Excel 2010 Workbook 
	 Step 1	 :	 Click on File tab.
			   Backstage view appears.
	 Step 2	 :	 Click on close.
			   Now the workbook closes.
Following are the steps to exit Microsoft Excel 2010.
	 Step 1	 :	 Click on the File tab.
			   Backstage view appears
	 Step 2	 :	 Click on the 🅇 Exit button.
			   If you have not saved the workbook, it will prompt to save the work-

book.
	 Step 3	 :	 Click on save to save the workbook.
Windows closes and the Desktop screen appears.
CO-SCHOLASTIC TASK
A. Microsoft Excel 2010 makes it possible to analyse, manage and share information 
in more ways than ever before. New analysis and visualisation tools help to track 
and highlight important data trends.
B.	1.	 Do yourself
	 2.	 Do yourself

Chapter 8
SCHOLASTIC TASK
A. 1. (a) 2. (c) 3. (a) 4. (c)
B. 1. (b) 2. (d) 3. (e) 4. (a) 5. (c)
C.	1.	 E-mail means electronic mail. It is similar to a regular postal letter, containing an 

address, routing information and content.
	 2.	 An e-mail address is a combination of username and a domain name. The username 

is an unique name that identifies us as an individual user.
		  Domain name is seperated into two parts by the (.) known as period. The username 

and domain name are seperated by a symbol (@).

	 3.	 The various headings visible on the first e-mail page are:
		  Inbox	 :	 In Inbox, we receive all the incoming mails.
		  Starred	 :	 We can star important mails.
		  Sent mail	 :	 In Sent Mail box, the mails which are sent are saved.
		  Draft	 :	 We can save any mail if we want to send it later. The mail gets 

saved automatically after 2 minutes if we have not sent it.
		  Trash	 :	  The mails that we delete, gets stored in the Trash box.

t a ta856@gmail.com

Usernam e At Domain
name
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		  Chats	 :	 In chats box, all the chats are saved.
	 4.	 Following are the steps to sign out an e-mail account:
 	 Step 1	 :	 Click on the down arrow of the Profile Picture. A drop down 

menu will appear.
	 Step 2	 :	 Click on Sign out.
CO-SCHOLASTIC TASK
Do yourself

Assessment C
A. Powerpoint is a presentation program developed by Microsoft Corp. It enables the users 
to create anything from basic slide shows to complex presentations. Powerpoint is a tool 
which is used to communicate ideas effectively through visual aids that look professionally 
designed and are easy to make.
B. 

Backward Command Forward Command
1. Backward or BK command instructs 

the turtle to move backward on the 
screen in the direction of the turtle's 
head.

1. Forward or FD command instructs the 
turtle to move forward on the screen in 
the direction of the turtle's head.

C. Do yourself
D. 

Assessment D
A. Yahoomail, Gmail, Hotmail
B. We can perform many tasks on LOGO by:
	 ●	 Constructing a program to perform all the tasks in the right order.
	 ●	 Evaluating the program to access whether the task is performed correctly.
	 ●	 Debugging the program by locating and correcting the errors or restructing the ap-

proach.
	 ●	 Experimenting with LOGO commands to understand them and beocme confident in 

their use.
	 ●	 Planning it into its various components.
	 ●	 Writing a set of instructions to perform each small task.
C. Do yourself
D. Follow these steps to sign in the e-mail account:
	 Step 1	 :	 Open Internet Explorer.
	 Step 2	 :	 Type the address in the address bar. The e-mail page will open.
	 Step 3	 :	 Type the e-mail address.
	 Step 4	 :	 Type the username and password.

yellowbird

Username At Domain
name

@ gmail.com
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	 Step 5	 :	 Click on sign in. Now, we are signed in the e-mail account.

Test Paper B
A. 1. (b) 2. (c) 3. (c) 4. (c) 5. (c)
B.	Bold
	 Italicize
	 Underline
C. 

LT Command RT Command
1. LT Command instructs the turtle to 

move in the left direction on the screen.
2. The command is followed by the degrees 

you want the turtle to rotate left.
3. 900 rotates the turtle exactly to the left.

1. RT Command instructs the turtle to move 
in the right direction on the screen.

2. The command is followed by the degrees 
you want the turtle to rotate right.

3. 900 rotates the turtle exactly to the right.

D.	 1.	 Tabs	 :	 Various tabs like Home, Insert, Page layout, Formulas, Data Re-
view and View are available in Microsoft Excel 2010 window.

	 2.	 Ribbon	 :	 It displays various commands of the tabs.
	 3.	 Formula Bar	 :	 It is used to enter formulas to perform calculations on the data.
	 4.	 Row Headings	 :	 It displays the row numbers.
E. 1. (b) 2. (d) 3. (e) 4. (a) 5. (c)
F.	 1.	 Following are the steps to open an already saved Microsoft Excel 210
	 Step 1	 :	 Click on file tab. Backstage view appears.
	 Step 2	 :	 Click on the open button. A list of recently opened Workbook will appear.
	 Step 3	 :	 If you want to open a workbook from another folder, the open dialog 

box appears.
	 Step 4	 :	 Click on these areas to locate the folder where the workbook is stored.
	 Step 5	 :	 Click on the name of the workbook you want to see
	 Step 6	 :	 Click on open.
The workbook will open in the Microsoft Excel 2010 program window.
	 2.	 Following headings are visible on the first e-mail page:
		  Inbox	 :	 In Inbox, you receive all the incoming mails.
		  Starred	 :	 You can star important mails.
		  Sent mail	 :	 In Sent Mail box, the mails which are sent are saved.
		  Draft	 :	 We can save any mail if we want to send it later. The mail gets 

saved automatically after 2 minutes if we have not sent it.
		  Trash	 :	 The mails that we delete, get stored in the Trash box.
		  Chats	 :	 In chats box, all the chats are saved.




